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Introduction to Election Outreach 

Election Outreach can be used to educate the public and help voters find an appropriate voting center 
or Election Day polling place. 

State and local governments strive to improve voter participation through open communication and a 
sense of collaboration. Elections departments look for ways to increase voter turnout and engage 
constituents but are faced with changing behaviors of citizens who seem disconnected from the 
democratic process. Helping voters locate where they can vote and understand voting alternatives 
removes voter confusion. Communicating wait times to voters reduces congestion at polling places or 
voting centers and increases participation by helping voters decide when they want to cast their ballot 
on Election Day. Election Outreach is typically implemented by clerks, election commissions, or secretary 
of state offices that want to inform voters and increase participation in the elections. 

The Election Outreach solution delivers a set of capabilities that help you share information about 
current elected representatives with the public, get voters to an appropriate voting center or Election 
Day polling place, communicate voting wait times and recruit poll workers. 

Learn more about the Election Outreach solution. 

 

See Deploy an ArcGIS Solution for more information. 

Requirements 

Election Outreach requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

Information products 

Election Outreach includes the following information products: 

Item Description 
Minimum user 
type 

Promoting 
Transparent 
Elections 

An ArcGIS Hub site used by the general public to access 
election information 

Not required 

My Elected 
Representative 

An ArcGIS Web AppBuilder app used by the general public 
to determine who represents them in local, state, and 
federal elected offices 

Not required 

Election Polling 
Places 

An ArcGIS Web AppBuilder app used by voters to locate a 
polling place where ballots can be cast on Election Day 

Not required 

Voting Centers An ArcGIS Web AppBuilder app used by voters to locate a 
voting center where ballots can be cast in person or by 
mail 

Not required 

https://doc.arcgis.com/en/arcgis-solutions/latest/get-started/get-started-with-arcgis-online.htm#ESRI_SECTION1_09F5BE7EA4D0496DA4AB3A3BDD8F01D2
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Poll Worker 
Application 

An ArcGIS Survey123 form used by the general public to 
volunteer to become a poll worker 

Not required 

Election Data 
Management 

An ArcGIS Pro project used by mapping technicians to 
inventory and maintain electoral districts, precincts, 
voting centers, and polling places 

GIS Professional 
Standard 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution item that 
organizes the key information products and summarizes all the ArcGIS items (applications, forms, 
projects, maps, feature layers, feature layer views, and so on) included with the solution. The ArcGIS 
Solution item also illustrates any dependencies items have on each other. 
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Configure Election Outreach 

In this topic, you will learn how to configure the Election Outreach solution to meet specific needs in 
your organization. 

Manage election data 

You will assume the role of a mapping technician responsible for maintaining an inventory of electoral 
districts, voting locations, and voting precincts. The Election Data Management ArcGIS Pro project 
includes a series of tasks to help guide you through these workflows. 

Get started 

To get started with Election Data Management, complete the following steps. 

• Sign in to your ArcGIS organization and browse to the Election Data Management Desktop 
Application Template. 

• Open the item page and click Download. 

•  Unzip and open the Election Data Management ArcGIS Pro project. 

• On the View tab, in the Windows group, click Catalog Pane. 

• In the Catalog pane, expand the Tasks folder, and double-click the Election Data Management task 
item. 

• In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

Election Data Management is used to load, create, and edit foundational election data used in Election 
solutions such as My Elected Representative, Election Polling Places, and Election Manager. The solution 
uses three foundational datasets: 

• Voting Locations 

• Voting Precincts 

• Electoral Districts 

Voting Locations contains facilities where voters can cast ballots and is defined by a point layer. They 
can be either polling places or voting centers, depending on your community's needs. Voting centers can 
be modified to allow early voting. 

Voting Precincts contains areas that define your community's precincts and is defined by a polygon 
layer. They are related to voting locations by a unique ID and define the unique polling place where 
voters in a precinct should cast ballots. 

Electoral Districts contains geographies that define an elected office's area of representation and is 
defined by a polygon layer. For example, a mayor's Electoral District is the municipal boundary. Key 
attributes are used in My Elected Representative solution. 

Before proceeding to subsequent tasks, follow the instructions in the Add election geography layer task 
to add the ElectionGeogrophy feature layer deployed with the solution. 

Load existing election data 

Your election agency may have existing polling place, voting center, voting precinct, or electoral district 
data, which can be loaded into the ElectionGeography feature layer. 
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Voting Locations are designated as either Polling Places or Voting Centers using the Voting Facility Type 
field. Both Voting Centers and Polling Places use a standard for operational days and hours in the Voting 
Centers and Election Polling Places apps included with the Election Outreach solution. To load existing 
voting location data, designate the type, and format the operation days and hours, follow the 
instructions in the Polling places and Voting centers tasks. 

The polling precinct’s relationship with a polling place is defined by populating the Polling Place ID field 
with the GlobalID from the corresponding polling place. Establishing this relationship allows the Election 
Polling Places app and the Election Outreach solution to display the appropriate polling place when a 
user searches by address or defines a location on the map. Follow the instructions in the Polling 
precincts task to load existing data and establish the relationship. 

Follow the instructions in the Load electoral district to load existing data. 

Create new election data 

You may need to create new election data if existing data is not available. Follow the instructions in the 
Create new election data task group to create new voting locations, voting precincts, or electoral 
districts. 

Note: 

Map layers must be visible to create new data. 

Prepare for next election 

Election data changes over time as new voting locations are established, precincts are modified, and 
election cycles are completed. You must update key fields such as the next election date to maintain 
election data accuracy and ensure that public facing apps included with the Election Outreach solution 
display the correct information. Use the Next election date and Early voting data tasks to update key 
data fields as election cycles are completed. Use the Modify voting locations, Modify precincts, and 
Modify electoral districts tasks to edit your election data. 

Modify elected offices 

My Elected Representative allows the general public to determine who represents them in local, state, 
and federal elected offices. My Elected Representative includes several elected office layers, such as 
Mayor, County Clerk, Governor, and United State Senate. You can modify the elected offices available in 
the app to fit your needs. For example, a city can configure My Elected Representative to display only 
locally elected offices. 

Update domain values 

Review the ElectionGeography feature layer elected offices and identify an elected office your 
organization you may want to add to My Elected Representative. 

• Verify that you are signed in to your ArcGIS organization and browse to the ElectionGeography 
feature layer. 

• Open the item page and click the Data tab. 

• Click Fields. 

• Click the Layer drop-down menu and choose Electoral Districts. 
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• In the list of fields, click the Elected Office display name. 

• In the List of Values (Domain) section, review the existing categories and identify ones that are not 
applicable and ones that are missing. 

• Click Edit next to List of Values (Domain). 

• Optionally, click the Delete button to remove a category from the list, and click Save. 

• Click Add. 

• Type the new elected office name into the Displayed Value and Stored Value text boxes. 

• Repeat steps 9–10 to add the remaining elected offices. 

• Optionally, drag the elected office to a new location in the list to reorder them. 

• Click Save. 

Update map 

Next you will configure the My Elected Representative map to display the elected offices you want to 
display in the My Elected Representative app. 

• Verify that you are signed in to your ArcGIS organization and browse to the My Elected 
Representative map. 

• Open the item page and click Open in Map Viewer Classic. 

• Click Details and click the Contents button. 

  The map Content pane displays a list of several preconfigured elected office map layers ranging 
from Mayor to President of the United States. Each layer is filtered using the Elected Office field on 
the Electoral Districts feature layer. 

• To remove an unneeded elected office layer, click More Options, and click Remove. 

• To copy a layer, click More Options and click Copy. 

  A new layer appears at the top of the Contents pane. 

• To update the new layer’s name, click More Options, click Rename, type the elected office name in 
the text box, and click OK. 

• Click Filter on the new layer. 

• Click the Edit tab. 

  An existing filter query displays Elected Office is Value. You will modify the query to display the 
elected office. The Value drop-down menu displays the values you configured in a previous task. 

• Choose the appropriate elected office domain value from the drop-down menu and click Apply 
Filter. 

• Optionally, drag the layer to a new location in the Contents pane. 

  Tip: 

  You can also configure existing layers using the above steps. Modify the name and filter of an 
existing layer to match your configuration needs. 
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• Click Save. 

Update app 

You will now configure the My Elected Representative app to use the elected offices configured in the 
My Elected Representative map. 

• Verify that you are signed in to your ArcGIS organization and browse to the My Elected 
Representative app. 

• Open the item page and click Edit Application. 

• Click the Widget tab. 

• Click Set the widgets in this controller. 

• Hover over the lower right corner of the Find My Elected Representative widget and click 
Configure this widget. 

• Click the Search Settings tab. 

• Click Set next to Select search layer(s) to configure the layers searched in the app. 

• Use the Select search layer(s) window to configure the layers searched in the app. 

  Check the check box next to each of the layers available. 

• Click OK. 

• Click Save. 

Share wait times 

When paired with the Election Management solution, Election Polling Places and Voting Centers can 
display election wait times on the map so that voters can make an informed decision about when to 
vote. 

Share polling place wait times 

The Election Polling Places map includes a Polling Place Wait Times layer that displays the current wait 
time. To share wait times in the Election Polling Places app, you’ll make use of the included Polling Place 
Wait Times map layer. 

• Verify that you are signed in to your ArcGIS organization and browse to the Election Polling Places 
map. 

• Open the item page and click Open in Map Viewer Classic. 

• Click Details and click the Content button. 

• Uncheck the Polling Places layer (do not remove). 

• Check the Polling Place Wait Times layer. 

  The map now displays the most recently reported wait time symbolized by the length of the wait 
reported. When an election is completed, and you want to remove the wait times symbol, turn on 
the Polling Places layer, and turn off the Polling Place Wait Times layer. 

• Click Save. 
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Share voting center wait times 

When paired with the Election Management solution, Voting Centers can display election wait times so 
that voters can make an informed decision about when to vote. The Voting Centers map includes a 
Voting Center Wait Times layer that displays the current wait time. To share wait times in the Voting 
Centers app, you’ll make use of the included Voting Center Wait Times map layer. 

• Verify that you are signed in to your ArcGIS organization and browse to the Voting Centers map. 

• Open the item page and click Open in Map Viewer Classic. 

• Click Details and click the Content button. 

• Uncheck the Voting Centers layer (do not remove). 

– Click Change Style. 

– Click Location (Single Symbol) style and click Options. 

– Move the transparency slider to set the transparency level to 100 percent. 

– Click OK. 

– Click Done. 

• Check the Voting Center Wait Times layer. 

  The map now displays the most recently reported wait time symbolized by the length of the wait 
reported. When an election is completed and you want to remove the wait times symbols, turn on 
the Voting Centers layer and set its transparency to 0 percent, and turn off the Voting Center Wait 
Times layer. 

• Click Save. 

Hide wait times 

When paired with the Election Management solution, Election Polling Places and Voting Centers will 
display election wait times in the information panel. In some cases, your organization may track election 
wait times for internal use without sharing those wait times in the public facing app. 

Hide polling place wait times 

On Election Day, the Election Polling Places app automatically displays wait times tracked using the 
Election Management solution. Follow the below steps to remove wait times from the Election Polling 
Places app. 

• Verify that you are signed in to your ArcGIS organization and browse to the Election Polling Places 
map. 

• Open the item page and click Open in Map Viewer Classic. 

• Click Details and click the Content button. 

• On the Polling Places layer, click More Options and click Configure Pop-up. 

• Click the Configure button. 

  Tip: 
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  Click the View HTML Source button in the editor. Copy and save all the HTML syntax into the 
editor. This allows you to restore wait times or discard changes. From the editor, you can copy 
and paste the original HTML syntax into the Custom Attribute Display window after clicking the 
View HTML Source button. 

• Delete {expression/expr0} from the pop-up. Backspace so the entire line is removed. 

  The result should look like this: 

   

• Click OK to close the Custom Attribute Display window. 

• Click OK to finish configuring the pop-up. 

• Click Save. 

  On Election Day, the pop-up does not display wait times but continues to display current 
information such as the Today is Election Day message and operational status. 

Hide voting center wait times 

A vote center can be open on Election Day as well as for a period prior to Election Day. When a vote 
center is open and active, the Voting Centers app automatically displays wait times tracked using the 
Election Management solution. Follow the below steps to remove wait times from the Voting Centers 
app. 

• Verify that you are signed in to your ArcGIS organization and browse to the Voting Centers map. 

• Open the item page and click Open in Map Viewer Classic. 

• Click Details and click the Content button. 

• On the Voting Centers layer, click More Options and click Configure Pop-up. 
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• Click the Configure button. 

  Because voting centers can be configured to be open on Election Day only or over a period of time, 
you will remove wait times from two places in the pop-up configuration. 

  Tip: 

  Click the View HTML Source button. Copy and save all the HTML syntax into the editor. This 
allows you to restore wait times or discard changes. From the editor, you can copy and paste the 
original HTML syntax into the Custom Attribute Display window after clicking the View HTML 
Source button. 

• Delete {expression/expr0} from the pop-up. Backspace so the entire line is removed. 

  The result should look like this: 

   

• Scroll until {expression/expr8} is visible. 

• Delete {expression/expr8} from the pop-up. Backspace so the entire line is removed. 

  The result should look like this: 
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• Click OK to close the Custom Attribute Display window. 

• Click OK to finish configuring the pop-up. 

• Click Save. 

  When a voting center is open and active, the pop-up does not display wait times but continues to 
display current information such as the This voting center is open message and operational status. 

Sharing solution items 

Several layer views, maps and apps included in the Election Outreach solution must be shared with 
everyone so they can be accessed by the public on the Promoting Transparent Elections site. To share 
your election outreach items with everyone, use the guide below and complete the following steps: 

• Verify that you are signed in to your ArcGIS organization and browse to the Election Outreach 
folder. 

• Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   VotingLocations_currentwait 

  Feature Layer (hosted, view)   ElectionGeography_public 

  Feature Layer (hosted, view)   PollWorkerApplications_public 

  Web Map   My Elected Representative 

  Web Map   Voting Centers 

  Web Map   Election Polling Places 
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  Web Mapping Application   My Elected Representative 

  Web Mapping Application   Voting Centers 

  Web Mapping Application   Election Polling Places 

  Form   Poll Worker Application 

  Hub Site Application   Promoting Transparent Elections 

  Hub Initiative   Promoting Transparent Elections 

  Note: 

  You will only have a Hub Initiative item if your organization has ArcGIS Hub Premium. 

• Click Share. 

•  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you are sharing 
editable layers publicly. 

• Click Update. 
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Use Election Outreach 

The Election Outreach solution delivers a set of capabilities that help you share information about 
current elected representatives with the public, get voters to an appropriate voting center or Election 
Day polling place, communicate voting wait times, and recruit poll workers. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing the 
workflows below. 

Note: 

Use the links below to try the apps with sample data provided by Esri, or use the workflows as a guide 
for using your own configured apps. 

Find elected representatives 

You will assume the role of a resident in the community who wants to find information on your election 
representatives. 

• In a browser, go to the Promoting Transparent Elections site and review the sections. 

• Scroll to the Who’s My Elected Representative section and click the Find My Representative 
button. 

  The My Elected Representative app opens in a new tab or window. 

• In the Find My Elected Representative widget, under Search for an address or locate on map, type 
1433 Terrance Dr, Naperville, IL in the search box and press the Enter key. 

• Review the list of elected offices. 

  Using the list of elected offices, you can discover your elected representatives and their contact 
information. For example, county commissioners are responsible for the management of county 
funds and have fiscal and regulatory powers. 

• In the Elected Representative list, click County Commissioner. 

  The list of county commissioners updates to display representatives. The number of 
representatives displayed in the pop-up varies by elected office. 

• Click the Back button to return to the list of elected representative. 

• In the Elected Representative list, click United State Senate to review senators representing this 
location. 

• When finished, close the My Elected Representative app and return to the Promoting Transparent 
Elections site. 

Find a polling place 

Many states divide communities into geographic areas and assign registered voters to designated polling 
places based on their residential address. On Election Day, ballots are cast at these designated polling 
places and then tabulated to determine the winner of a political contest or proposal. 

You will assume the role of a voter interested in locating the polling place where your ballot can be cast 
on Election Day. 

• In a browser, go to the Promoting Transparent Elections site. 



13 

 

• Scroll to the Voting Locations section and click the Find Polling Place button to open the My 
Elected Representative app. 

• In the Find My Polling Place widget, under Search for an address or locate on map, type 1433 
Terrance Dr, Naperville, IL in the search box and press the Enter key. 

  The map updates to display the area covered by the voting precinct where the address is located. 

  The Information tab displays details about the polling place such as the election date, location, 
operational hours, and status. 

• Click the Directions tab.  

  The tab displays turn-by-turn directions from the address to the polling station. 

• On the map, zoom out and note that the area surrounding your initial address has multiple polling 
places serving voters. 

• Click a different location on the map and observe how the app identifies a different precinct and 
how polling place details on the Information tab are updated. 

  Information in the pop-up varies by location, depending on the election details. 

• Click the Directions tab to view turn-by-turn directions to the polling place. 

• When finished, close the Election Polling Places app and return to the Promoting Transparent 
Elections site. 

Locate voting centers 

Voting centers are an alternative to traditional, neighborhood-based precincts. When a jurisdiction opts 
to use voting centers, voters may cast their ballots on Election Day at any voting center in the 
jurisdiction, regardless of their residential address. Voting centers may also communicate early voting 
options such as mail-in drop boxes. 

As a voter in the community, you are also interested in locating nearby voting centers and early voting 
options. 

• In a browser, go to the Promoting Transparent Elections site. 

• Scroll to the Voting Locations sections and click the Find Voting Centers button to open the Voting 
Centers app. 

• In the Locate Voting Center widget, click and slide the buffer distance to 5 miles. 

  The slider allows a user to define a distance within which to locate voting centers once an address 
is entered or a location is identified on the map. 

• Under Search for an address or locate on map, type 1433 Terrance Dr, Naperville, IL in 
the text box and press the Enter key. 

  The map updates to display a proximity of 5 miles around the address location. 

• Click Naperville Municipal Center from the search results. 

  The Information tab displays center-specific information such as location details, operational 
hours, status, and drop box location. 

• Click the Directions tab. 
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  The tab displays turn-by-turn directions from the address to the voting center. 

  The information in the pop-up varies by location, depending on the election details. 

View wait time at a polling place 

Communicating wait times to voters can reduce congestion at polling places and voting centers as well 
as help voters decide when to cast their ballot on Election Day. 

You'll assume the role of a voter on Election Day. Previously, you've located your polling place using the 
Election Polling Places app. You're now interested in using the app to view the current wait time to 
decide when to cast your ballot. 

• In a browser, go to the Election Polling Places app. 

• In the Find My Polling Place widget, under Search for an address or locate on map, type 1433 
Terrance Dr, Naperville, IL in the text box and press the Enter key. 

  The Information tab updates to display details on the closest polling place to your address, 
including location, operational hours, and status. In addition, the tab reports the approximate wait 
time, which is also visualized on the map, where polling place symbols are color-coded according 
to reported wait times. 

• Click the Directions tab. 

  The tab displays turn-by-turn directions from the address to nearest polling place. 

• On the map, zoom out and review additional polling places. 

  Note: 

  Depending on when you access the app, you will see an operational status of Open Now or 
Closed below the hours of operation. 

View wait times at voting centers 

After locating a voting center using the Voting Centers app, you are interested in using the app to view 
current wait times to decide when best to cast your ballot. 

• In a browser, go to the Voting Centers app. 

• In the Locate Voting Center widget, click and slide the buffer distance to 5 miles. 

• Under Search for an address or locate on map, type 1433 Terrance Dr, Naperville, IL in 
the text box and press the Enter key. 

  The Locate Voting Center widget and the map update to display several voting centers within a 5 
mile radius of your location. 

  Voting centers symbols on the map are color-coded according to reported wait times. Notice that 
the Naperville Municipal Center appears to be the closest voting center to your location but has a 
30-minute wait time. Bolingbrook Fire Station #4 is slightly further away but has a wait time of 5 
minutes. 

• Click Bolingbrook Fire Station #4 from the search results. 
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  Note: 

  Both the map and the pop-up display the current wait time as reported by the local election 
office. The map symbol is color-coded according to the wait time reported. 

  In addition to the current wait time, the pop-up also displays election day information such as 
location details and operational hours and status. Bolingbrook Fire Station #4 is an early voting 
location. The pop-up displays both a current status message and weekly operation hours. 

  Note: 

  Depending on when you access the app, you will see an operational status of Open or Closed to 
the right of today's hours of operation. 

Volunteer as a poll worker 

As an engaged voter in the community, you want to volunteer to help conduct transparent elections as a 
poll worker. You will fill out a survey to provide your contact information and qualifications so the 
election agency can connect with you about election volunteer opportunities. 

• In a browser, go to the Promoting Transparent Elections site. 

• Scroll to the Volunteer as a poll worker section and click the Volunteer button to open the 
Become a Poll Worker survey. 

• Complete the survey and click Submit. 

 


